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Software for MAGICSTOMP
Guia de Instalação

AVISOS ESPECIAIS

• É expressamente proibido copiar os softwares ou a reproduzir este guia, total ou parcialmente, por
quaisquer meios, sem o consentimento por escrito do fabricante.

 
• A Yamaha não faz representações nem garantias a respeito de quaisquer problemas decorrentes do uso

dos softwares e deste guia.
 
• É expressamente proibido copiar a música disponibilizada comercialmente, exceto para uso pessoal.
 
• As telas ilustradas neste Guia de Instalação têm objetivo didático, e podem aparecer ligeiramente

diferentes das telas que aparecem no computador.

• As indicações OMS® e  que aparecem neste Guia de Instalação são marcas registradas da Opcode
Systems, Inc.

• Os nomes de empresas e produtos citados neste Guia de Instalação são marcas comerciais ou registradas
das respectivas empresas.

• As atualizações futuras do software aplicativo e do software do sistema e quaisquer alterações nas
especificações e funções serão anunciadas separadamente.

Este Guia de Instalação assume que você já está familiarizado com as operações básicas do
Windows / Macintosh. Caso não esteja, favor consultar o manual que acompanha seu sistema
operacional Windows / Mac OS antes de usar o Sound Editor.

Para informações sobre o requisitos de software e hardware, e sobre as interconexões de
dispositivos que são necessárias para usar o Sound Editor for MAGICSTOMP, favor
consultar o manual que vem com o MAGICSTOMP.

As ilustrações de telas neste manual foram extraídas principalmente do Windows. As
diferenças que existem para o Macintosh são devidamente mostradas e explicadas.

© 2003 Yamaha Corporation. Todos os direitos reservados.
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Usuários de Windows

Instalação do Software

Desinstalação (removendo o
software instalado)
Você pode remover o software aplicativo instalado.
Selecione [Iniciar] (→ [Configurações])
→ [Painel de Controle] → [Adicionar / Remover
Programas] → [Instalar/Desinstalar], e em seguida
selecione o aplicativo a ser removido e clique em
[Adicionar/Remover...].
Siga as instruções na tela para desinstalar o aplicativo.

NOTA: Os nomes dos botões ou menus podem ser
diferentes dependendo do sistema operacional
do computador.

Driver USB MIDI

Para poder transferir os dados entre o MAGICSTOMP
e o computador, é necessário instalar apropriadamente
no computador o driver USB-MIDI.
Antes de instalar o aplicativo, verifique o sistema
operacional usado em seu computador e então instale.

       computador

• • Instalando o driver no Windows 98/Me

1. Inicie o computador.

2. Insira na unidade de CD-ROM o CD-ROM fornecido
com o MAGICSTOMP.

3. Desconecte a fonte de alimentação (adaptador AC) do
MAGICSTOMP e em seguida use o cabo USB fornecido
para conectar a porta USB do seu computador (ou do hub
USB) à conexão de USB do MAGICSTOMP. Em
seguida, conecte a fonte de alimentação do
MAGICSTOMP (ligando o MAGICSTOMP), o que fará
aparecer automaticamente o “Assistente para Instalação”
do Windows na tela do computador.

NOTA: Usuários do Windows Me devem marcar a opção
“Procurar automaticamente o melhor driver
(Recomendado)” e clicar em [Avançar]. O
sistema inicia automaticamente a procura e
instalação do driver. Prossiga até o passo 8. Se o
sistema não detectar o driver, selecione
“Especificar o local do driver (Avançado)” e
especifique a pasta “USBdrv_” no CD-ROM para
instalar o driver

4. Clique em [Avançar].
A janela abaixo permite a você selecionar o método de
procura.

cabo USB
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5. Marque a opção “Procurar automaticamente o melhor
driver (Recomendado)”. Clique em [Avançar]. A janela
abaixo permite a você selecionar o local a partir de onde
deseja instalar o driver.

6. Marque a opção “unidade de CD-ROM” e desmarque os
demais itens. Clique em [Avançar].

NOTA: O sistema pode solicitar que você insira o CD-
ROM do Windows enquanto verifica a unidade.
Especifique a pasta USBdrv_ da unidade de CD-
ROM (ex: D:\USBdrv_\) e continue a instalação.

NOTA: Se estiver usando o Windows 98, especifique a
pasta USBdrv_ na unidade de CD-ROM (ex:
D:\USBdrv_\) e continue a instalação.

7. Quando o sistema detecta o driver no CD-ROM e está
pronto para a instalação, ele mostra a tela a seguir.
Certifique-se de que está listado “YAMAHA USB MIDI
Driver”, e clique em [Avançar]. O sistema inicia a
instalação.

8. Quando a instalação está completa, aparece a tela a
seguir. Clique em [Concluir].

NOTA: Alguns computadores podem levar cerca
de dez segundos ou mais para mostrar essa
tela após a instalação estar completa.

O driver está instalado.
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• • Instalando o driver no Windows 2000

1. Inicie o computador e faça o log usando a conta do
“Administrador”.

2. Selecione [Meu Computador | Painel de Controle |
Sistema | Hardware | Assinatura de Driver | Verificação
de Assinatura], e marque a opção “Ignorar - Instalar o
software assim mesmo” e clique em [OK].

3. Insira na unidade de CD-ROM o CD-ROM fornecido.

4. Desconecte a fonte de alimentação (adaptador AC) do
MAGICSTOMP e em seguida use o cabo USB fornecido
para conectar a porta USB do seu computador (ou do hub
USB) à conexão de USB do MAGICSTOMP. Em
seguida, conecte a fonte de alimentação do
MAGICSTOMP (ligando o MAGICSTOMP), o que fará
aparecer automaticamente o “Assistente para Instalação
de Novo Hardware” do Windows na tela do computador.

5. Marque a opção “Procurar o melhor driver para o
dispositivo (Recomendado)”. Clique em [Avançar]. A
janela que aparece permite a você selecionar o local a
partir de onde deseja instalar o driver.

6. Marque a opção “unidade de CD-ROM” e desmarque os
demais itens. Clique em [Avançar].

NOTA: O sistema pode solicitar que você insira o CD-
ROM do Windows enquanto verifica a unidade.
Especifique a pasta USBdrv2k_ da unidade de
CD-ROM (ex: D:\USBdrv2k_\) e continue a
instalação.

7. Ao terminar a instalação, o sistema mostrará a mensagem
“Completando a instalação do novo hardware”. Clique
em [Concluir].

NOTA: Alguns computadores podem levar cerca de
dez segundos ou mais para mostrar essa tela
após a instalação estar completa.

8. Reinicie o computador. O driver foi instalado.

• • Instalando o driver no Windows XP

1. Inicie o computador.

2. Selecione [Iniciar] → [Painel de Controle]. Se o Painel
de Controle aparecer como mostrado abaixo, clique em
“Menu Iniciar clássico”

3. Entre em [Sistema] → [Hardware] → [Assinatura de
Driver] → [Opções de assinatura de driver], marque a
opção “Ignorar - instalar o software assim mesmo” e
clique em [OK].

4. Clique no botão [OK] e feche as Propriedades do
Sistema, e em seguida clique no “X” do canto superior
direito da janela para fechar o Painel de Controle.

5. Insira na unidade de CD-ROM o CD-ROM fornecido
com o MAGICSTOMP.

6. Desconecte a fonte de alimentação (adaptador AC) do
MAGICSTOMP e em seguida use o cabo USB fornecido
para conectar a porta USB do seu computador (ou do hub
USB) à conexão de USB do MAGICSTOMP. Em
seguida, conecte a fonte de alimentação do
MAGICSTOMP (ligando o MAGICSTOMP), o que fará
aparecer automaticamente o “Assistente para Instalação”
do Windows na tela do computador.

7. Marque a opção “Procurar automaticamente o melhor
driver (Recomendado)”. Clique em [Avançar]. O sistema
inicia a instalação do driver.

8. Ao terminar a instalação, o sistema mostrará a mensagem
“Completando a instalação do novo hardware”. Clique
em [Concluir].

NOTA: Alguns computadores podem levar cerca de
dez segundos ou mais para mostrar essa tela
após a instalação estar completa.

9. Reinicie o computador. O driver foi instalado.
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Instalando o Sound Editor for
MAGICSTOMP

1. Insira na unidade de CD-ROM o CD-ROM fornecido.
Aparecerá CDROM (X4770A0) em “Meu Computador”.

2. Clique no ícone do CD-ROM para abrir, e em seguida
clique duas vezes na pasta "Tools". Aparecerá
“Setup.exe” e outros arquivos.

3. Clique duas vezes no arquivo “Setup.exe”. Aparecerá o
quadro “Sound Editor for MAGICSTOMP”.

4. Siga as instruções na tela para instalar o aplicativo.

5. Após completar a instalação, reinicie o computador.
Após reiniciar o computador, você perceberá que a pasta
“YAMAHA” foi adicionada (provavelmente em
Arquivos de Programas) e que a pasta “SGP Tools” foi
criada dentro dela. A instalação do Sound Editor for
MAGICSTOMP estará completa.

Iniciando e configurando o
Sound Editor

Depois de ter instalado os drivers e o Sound Editor for
MAGICSTOMP, siga os passos abaixo para iniciar o
aplicativo Sound Editor for MAGICSTOMP e efetuar as
configurações necessárias.

1. No menu “Iniciar”, selecione “Programas” →“YAMAHA
SGP Tools” →“Sound Editor for MAGICSTOMP” →
“Sound Editor for MAGICSTOMP”.

2. O Sound Editor for MAGICSTOMP inicia.
Após aparecer a barra de ferramentas do MAGICSTOMP
Setup mostrada abaixo, clique no botão MAGICSTOMP
Setup.

botão MAGICSTOMP Setup

3. Clicando no botão MAGICSTOMP Setup faz abrir o
quadro Setup. Configure as portas MIDI apropriadas
(IN/OUT/THRU) para usar o MAGICSTOMP conectado.
As configurações normais são as seguintes:
In ................. configurar para “YAMAHA USB IN 0-1”
Out .............. selecionar “YAMAHA USB OUT 0-1”
Thru ............ selecionar “NONE”

4. Clique no botão Editor Setup na barra de ferramentas da
janela Library para abrir o quadro Editor Setup.

        botão Editor Setup

5. Configure as portas de entrada e saída ou os números de
dispositivos apropriados para permitir a comunicação
entre o Sound Editor e o MAGICSTOMP.

NOTA: Para mais informações sobre o quadro Editor
Setup, consulte o texto no arquivo PDF “Sound
Editor for MAGICSTOMP Manual” disponível
na pasta “Manual” do CD-ROM.
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Agora que a configuração está completa, você pode usar o
Sound Editor for MAGICSTOMP.
Estas configurações são salvas quando você sai do Sound
Editor for MAGICSTOMP, de forma que na próxima vez que
você iniciar o aplicativo não será necessário configurar
novamente.
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Usuários de Macintosh

Instalação do Software

Open Music System (OMS) 2.3.8

O OMS permite a você usar vários aplicativos MIDI no Mac
OS ao mesmo tempo.
Se você já possui o OMS instalado em seu computador, não é
necessário reinstalá-lo.

1. Inicie o computador.

2. Insira na unidade de CD-ROM o CD-ROM fornecido. O
sistema mostrará o ícone do CD-ROM na área de
trabalho (desktop).

3. No CD-ROM → pasta “International” → clique duas
vezes na pasta “OMS”.
Será mostrado “Install OMS 2.3.8”.

4. Clique duas vezes em “Install OMS 2.3.8”.
Será mostrado o quadro OMS Setup.

5. Execute a instalação seguindo as instruções na tela.
Após a instalação, selecione “Restart”.

NOTA: Após completar a instalação, existe a
possibilidade de ser apresentada uma mensagem
de erro avisando que o instalador não foi fechado.
Nesse caso, entre no menu “File” e selecione
“Quit” para fechar o instalador. Em seguida
reinicie o computador. Após reiniciar o
Macintosh, você encontrará a pasta “Opcode” /
“OMS Applications” no seu computador (em
geral, localizada em Hard Disk).

6. No CD-ROM → pasta “International” → pasta “OMS”
→ copie a pasta “OMS Setup for Yamaha” para a pasta
“OMS Applications” (clicando e arrastando a pasta).
Na pasta “OMS Setup for Yamaha” você encontrará o
arquivo de configuração OMS Setup para o MAGIC-
STOMP, designado como “USB-MAGICSTOMP”. Use
este arquivo para configurar o OMS (página 9).

Driver USB MIDI

Para operar o MAGICSTOMP a partir do seu computador,
via USB, você precisará instalar o driver de software
apropriado.
O driver USB-MIDI é o software que transfere os dados de
MIDI de um lado para o outro entre o software seqüenciador
e o MAGICSTOMP, através do cabo USB.

           computador

Além disso, após instalar o driver USB-MIDI, você precisará
configurar o OMS (página 9).

1. Inicie o computador.

2. Insira na unidade de CD-ROM o CD-ROM fornecido. O
sistema mostrará o ícone do CD-ROM na área de
trabalho (desktop).

3. No CD-ROM → pasta “International” → pasta
“USBdrv_” → clique duas vezes no ícone “Install USB
MIDI Driver”.

4. O quadro “Install Location” mostra o destino da
instalação. Se você quiser modificar o disco ou pasta de
destino, use o botão [Switch Disk] e o menu para
especificar o destino desejado.

NOTA: Como este quadro usualmente mostra o disco de
partida como destino, não é preciso modificar.

5. Clique no botão [Install]. O sistema mostrará a seguinte
mensagem: “This installation requires your computer to
restart after installing this software. Click Continue to
automatically quit all other running applications”.
Clique em [Continue].

NOTA: Para cancelar a instalação, clique em [Cancel].

cabo USB
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6. A instalação é iniciada. Caso o driver já tenha sido
instalado, aparecerá a mensagem abaixo. Para retornar ao
passo 3, pressione [Continue]. Para completar a
instalação, clique [Quit].

7. Quando a instalação é completada, o sistema mostra a
seguinte mensagem: “Installation was successful. You
have installed software which requires you to restart your
computer”. Clique em [Restart]. O computador reinicia
automaticamente. Você pode localizar os arquivos
instalados nos seguintes locais:

• System Folder | Control Panels | YAMAHA USB
MIDI Patch

• System Folder | Extensions | USB YAMAHA MIDI
Driver

• System Folder | OMS Folder | YAMAHA USB MIDI
OMS Driver

Instalando o Sound Editor for
MAGICSTOMP

1. Inicie o computador.

2. Insira na unidade de CD-ROM o CD-ROM fornecido. O
sistema mostrará o ícone do CD-ROM na área de
trabalho (desktop).

3. No CD-ROM → pasta “International” → pasta “Tools”
→ clique duas vezes na pasta
“SoundEditorForMAGICSTOMPe.sea”.
O arquivo é expandido e o quadro “Install Location”
mostra o destino para a instalação.

4. Selecione o destino para a instalação e clique no botão
“Install”.

A instalação do Sound Editor for MAGICSTOMP está
completa.
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Configuração do Sound Editor
Após completar a instalação dos drivers e do Sound Editor for
MAGICSTOMP, siga os passos abaixo para iniciar o Sound
Editor e efetuar as configurações apropriadas.

Configurando o OMS
1. Use um cabo USB para conectar o terminal USB do

computador (ou do hub USB) ao terminal USB do
MAGICSTOMP e ligue a fonte de alimentação do
MAGICSTOMP (conecte o adaptador AC).

2. Inicie o computador.

3. Abra as pastas “Opcode” → “OMS Application”, e em
seguida na pasta “OMS Setup for Yamaha” clique duas
vezes no arquivo de configuração “USB-MAGICSTOMP”
para iniciar o OMS Setup.
NOTA: O arquivo “USB-MAGICSTOMP” deve ter sido

copiado para o disco rígido de seu computador no
procedimento da página 7. Se o arquivo não foi
copiado, siga o passo 7 descrito no tópico “Open
Music System (OMS) 2.3.8” da página 7 e copie o
arquivo para seu disco rígido.

4. Após iniciar o OMS Setup, é aberto o arquivo de
configuração Studio clicado no passo 3.

      indica que esta configuração está disponível

NOTA: Se não houver um losango à direita do nome do
arquivo, selecione “Make Current” no menu “File” e
efetue a operação Save.

A configuração do OMS Studio está completa.

NOTA: Após completar a configuração do OMS Studio
descrita acima, o seu computador reconhecerá
somente o MAGICSTOMP como instrumento MIDI.
Caso você use outro instrumento MIDI além do
MAGICSTOMP ou adicionar um segundo
MAGICSTOMP ao sistema existente, você deverá
criar um arquivo original Studio Setup. Para
detalhes, consulte o manual fornecido com o OMS.

NOTA: Mesmo seguido o procedimento acima, o arquivo de
configuração OMS Studio pode não funcionar,
dependendo da versão do seu Macintosh/Mac OS
(os dados de MIDI não podem ser transmitidos ou
recebidos mesmo que a configuração tenha sido
disponibilizada). Nesta situação, conecte o seu
Macintosh ao MAGICSTOMP por meio do cabo
USB e siga o procedimento abaixo para recriar o
arquivo de configuração.

1.  Inicie o OMS Setup e selecione “New Setup” no
menu “File”.

2. Aparece o quadro “OMS Driver Search”. Desmarque
as opções “Modem” e “Printer”, e clique em [Search]
para executar a busca do dispositivo. Se a busca for
completada com sucesso, o dispositivo [USBMIDI] é
mostrado no quadro de configuração do driver OMS.

3.Clique no botão [OK] para procurar as portas. Aparecerão no
quadro: Port 1, Port 2 ... Marque as opções das portas apropriadas
e clique no botão [OK] para salvar a configuração.

Configurando o Sound Editor for
MAGICSTOMP

1. Abra “Chooser” no Apple Menu, e em seguida abra e
desabilite o “Apple Talk”.

NOTA: Se o Apple Talk estiver ativo, aparecerá um aviso
quando o Sound Editor iniciar. Se isso ocorrer,
selecione “Set to OFF”. Levará algum tempo para
o Apple Talk ser desabilitado.

2. Na pasta “Sound Editor for MAGICSTOMP E” de
seu disco rígido, clique duas vezes no ícone
“SoundEditorForMAGICSTOMP”.

3. O aplicativo Sound Editor for MAGICSTOMP
iniciará.

4. No menu “MIDI” do Sound Editor for MAGICSTOMP,
selecione “OMS Port Setup”. Aparecerá o quadro “OMS
Port Setup”.

5. No exemplo a seguir, o MAGICSTOMP é o dispositivo
MIDI e suas configurações são aplicadas ao OMS.

Keyboard Thru.........  Configure para OFF (desmarcar)
MIDI In ....................  Selecione “MAGICSTOMP 1”
MIDI Out .................  Selecione “MAGICSTOMP 1”

6. Clique em “OK” para fechar o quadro.

Com isso a configuração estará completa e o Sound
Editor for MAGICSTOMP pronto para ser usado. Essas
configurações são salvas ao se sair do Sound Editor for
MAGICSTOMP, de maneira que na próxima vez que
você iniciar o aplicativo não será necessário configurar
novamente.
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Para usuários de Windows/Macintosh

Sobre a janela USB Driver Setup
Nesta janela, você pode alterar o número da porta MIDI transmitido para o MAGICSTOMP do número configurado no Sound Editor
for MAGICSTOMP (no caso do MAGICSTOMP, as configurações originais não precisam ser alteradas).
No Windows, selecione [Iniciar] (→ [Configurações]) → [Painel de Controle] → [MIDI-USB Driver] para abrir a janela de
configuração do driver.
No Mac, selecione [Apple] menu → [Painéis de Controle] → [YAMAHA USB MIDI Patch] para abrir a janela de configuração.

As configurações originais são as seguintes.

Número
da Porta

terminal MIDI OUT
(número Thru Port *)

terminal MIDI IN
(número Track Port)

1 MIDI OUT (1) MIDI IN (1)
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Soluções de problemas
O driver não pode ser instalado.
• O cabo USB está conectado corretamente?

→ Verifique a conexão do cabo USB (Manual do
Proprietário do MAGICSTOMP)

→ Desconecte o cabo USB, e em seguida conecte-o
novamente.

Windows
• A função USB está habilitada em seu computador?

→ Quando você conecta o MAGICSTOMP ao computador
pela primeira vez, se o “Assistente para Instalação de
Novo Hardware” (páginas 2, 4) não aparece é porque a
função USB do computador pode estar desabilitada.
Execute os seguintes passos:

1. Selecione [Painel de Controle] → [Sistema] →
[Gerenciador de Dispositivos] (no Windows 98/Me),
ou selecione [Painel de Controle] (Windows XP;
Classic View) → [Sistema] → [Hardware] →
[Gerenciador de Dispositivos] (no Windows 2000 /
XP).

2. Certifique-se de que não qualquer indicação de “!” ou
“x” nos itens “Controlador Serial Universal” ou “USB
Root Hub”. Caso haja alguma marca “!” ou “x”,
significa que o controlador USB está desabilitado.
Para mais informações, consulte o manual do seu
computador.

• Existe algum dispositivo desconhecido registrado?
→ Caso a instalação do driver tenha falhado, o

MAGICSTOMP estará marcado como “Dispositivo
desconhecido”, e você não poderá instalar o driver.
Exclua o “Dispositivo desconhecido” seguindo os passos
abaixo.

1. Selecione [Painel de Controle] → [Sistema] →
[Gerenciador de Dispositivos] (no Windows 98/Me),
ou selecione [Painel de Controle] (Windows XP;
Classic View) → [Sistema] → [Hardware] →
[Gerenciador de Dispositivos] (no Windows 2000 /
XP).

2. Procure o item “Outros dispositivos” no menu
“Visualizar dispositivos por tipo” Dispositivo
desconhecido”. Caso apareça algum, selecione-o e
clique no botão [Remover].

4. Remova o cabo USB do MAGICSTOMP, e faça a
conexão novamente.

5. Instale o driver novamente. (página 2)

Ao controlar o MAGICSTOMP pelo
computador via USB, o MAGICSTOMP não
opera corretamente ou nenhum som é
ouvido.
• Você instalou o driver? (Windows: página 2, Mac: página 7)

→ O cabo USB está conectado corretamente? (Manual do
Proprietário do MAGICSTOMP)

→ O volume está diferente do mínimo no MAGICSTOMP,
no equipamento de áudio ou no aplicativo?

→ A porta apropriada está selecionado no Sound Editor for
MAGICSTOMP?

→ O driver mais recente está instalado?
→ O efeito está desligado ("OFF")? O MAGICSTOMP está

no modo Tuner, Store, ou Name Edit? Certifique-se de
que o MAGICSTOMP está em seu modo normal de
operação (selecione um programa e ligue o efeito).

Não é possível suspender ou retornar o
computador corretamente.
• Se você estiver usando o Windows 2000, você pode não ser

capaz de  suspender/retornar normalmente, dependendo do
ambiente específico (USB Host Controller, etc.). Mesmo
assim, basta desconectar e conectar o cabo USB novamente
para permitir que você use de novo as funções do
MAGICSTOMP.

Como posso remover ou reinstalar o
driver?

Windows Me/98
1. Quando o MAGICSTOMP é reconhecido corretamente,

clique duas vezes em “Sistema” no Painel de Controle
para abrir a janela Sistema.

2. Clique duas vezes na ficha “Gerenciador de
Dispositivos”, selecione “YAMAHA USB MIDI Driver”
e exclua-o (delete).

3. Use o prompt do MS-DOS ou o Explorer para apagar os
arquivos listados abaixo.

NOTA: Para apagar os arquivos abaixo usando o Explorer,
selecione “Opções de pasta” no menu Ferramentas (ou
Exibir), e selecione “Mostrar todos os arquivos (e
pastas).”
• \WINDOWS\INF\OTHER\YAMAHAUB99.INF
• \WINDOWS\SYSTEM\Xgusb.drv
• \WINDOWS\SYSTEM\Ymidusb.sys

4. Desconecte o cabo USB.
5. Reinicie o computador.
6. Re-instale o driver. (página 2)

Macintosh
1. Exclua os arquivos nos seguintes locais:

• System Folder | Control Panels | YAMAHA USB
MIDI Patch

• System Folder | Extensions | USB YAMAHA MIDI
Driver

• System Folder | OMS Folder | YAMAHA USB MIDI
OMS Driver

2. Reinicie o computador.
3. Re-instale o driver. (página 7) e configure o OMS

(página 9).


